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Audacity ili kako snimiti i obraditi zvuk u vlastitoj produkciji (R500)

Uvod

Na ovoj radionici polaznik ¢e se upoznati s osnovama uporabe
besplatnog programa Audacity za snimanje i obradu zvuka.

Na radionici ¢e polaznici ste€i osnovnu razinu znanja o zvuku i
njegovim karakteristikama te ¢e nauciti termine koji se koriste prilikom
obrade zvuka. Naucit ée se koristiti mikrofonom i osnovnim alatima u
programu Audacity za snimanje, reprodukciju i obradu zvuka,
dodavanje efekata te ¢e se upoznati s formatima za uvoz i izvoz
zvuénih zapisa.

Za oznacCavanje vaznijih pojmova, naziva naredbi i elemenata sucCelja
te naziva drugih objekata koji se nalaze na ekranu, koriste se
podebljana slova.

Put do naredbe pisan je kurzivom, a sama naredba podebljano,
primjerice Edit - Remove Special - Split cut.

Prec&aci na tipkovnici oznaceni su ovako: [F1], [CtrI]+[Alt]+[Del] i sl.
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1. Zvuk i njegove karakteristike

Po zavrSetku ovog poglavlja polaznik ¢e moci:

o navesti karakteristike zvuka i osnovne termine povezane s
obradom i snimanjem zvucnih zapisa

o razlikovati niske i visoke frekvencije zvuka
° razlikovati intenzitete zvuka

e  opisati karakteristike tona zvuka.

1.1. Zvuk

Zvuk je mehanicki val, odnosno vibracija koja se Siri preko medija, kao
§to su zrak ili voda. U psihologiji i fiziologiji, zvuk predstavlja
mogucnost registriranja tih mehanickih valova i njihovu percepciju u
mozgu.

Zvuk stvaraju objekti ili subjekti vibracijom. Na isti nacin vibriraju slusni
organi, $to zivim bi¢ima omogucuje da Cuju razliCite vrste zvukova.

Na sljedeco;j slici prikazan je izvor zvuka (bijeli krug) i vibracije koje taj
izvor stvara.

Izvor: https://upload.wikimedia.org/wikipedia/commons/8/82/Spherical pressure_waves.qif

Zvuk karakteriziraju frekvencija i jacina. Da bi ljudi €uli zvuk, vrijednosti
frekvencije i jaine moraju biti u razini €ujnosti slusnih organa.

1.1.1. Frekvencija zvuka

Frekvencija zvuka oznacCava broj ponavljanja valova ili vibracije u nekoj
jedinici vremena.
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https://upload.wikimedia.org/wikipedia/commons/8/82/Spherical_pressure_waves.gif

Audacity ili kako snimiti i obraditi zvuk u vlastitoj produkciji (R500)

Visina zvuka vezana je uz frekvenciju i to tako da ako se povecava
frekvencija zvuka, povecéava se i visina.

Kako visina zvuka ovisi o frekvenciji i kako izgledaju valovi razli€itih
frekvencija prikazano je u animaciji na web-stranici
https://meettechniek.info/additional/additive-synthesis.html.

1.1.2. Jacéina zvuka

Jedinica za jaCinu zvuka (subjektivni intenzitet) je Bell. Granica Cujnosti
jest 0 dB, dok se Sapat, govor i buka kre¢u od 30 do 90 dB, a granica
boli je 120 dB.

Jacdina zvuka graficki se prikazuje visokim i niskim amplitudama:

1.1.3. Ton zvuka

Ton je zvuk koji uz visinu i jacinu karakteriziraju jos trajanje i boja, sto
ga razlikuje od drugih, neodredenih zvukova (kao $to je, na primjer,
Sum).

Trajanje ovisi 0 vremenu emitiranja zvu¢nog vala.
Ton traje sve dok izvor zvuka proizvodi vibracije.

Boja ovisi o broju i jagini popratnih tonova koji se javljaju istodobno s
glavnim tonom. lako ih nije mogucée svjesno prepoznati sluhom, utjecu
na ljudsku percepciju tona jer mu pridaju specifi¢no i prepoznatljivo
zvucanje - boju.

1.2. Snimanje, obrada i reprodukcija zvuka

Zvuk se moZe snimati, obradivati i reproducirati.

Za snimanje se koristi mikrofon koji sluzi kao prijemnik zvucnih valova i
pretvara zvu€ne valove u elektri¢ni signal koji se kodira u slijed
digitalnih vrijednosti. Obrada zvuka odnosi se na manipuliranje
digitalnim podacima u rac¢unalnom programu.

Digitalni podaci, koji se u raCunalu definiraju kao zvuéni format,
reproduciraju se stvaranjem elektri€nih signala koji pomocéu zvucnika
stvaraju zvuéne valove.



https://meettechniek.info/additional/additive-synthesis.html
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Uredaji za pohranu

Zvuéni valovi

Zvuéni valovi

Elektritna Zvutnik

energija

Izvor: https://en.wikipedia.org/wiki/Digital_audio#/media/File:A-D-A_Flow.svg
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1.3. Vjezba: Zvuk i njegove karakteristike

1.

Zvuk je (moguce je vise odgovora):
a. mehanicki val
b. vibracija koja se Siri preko nekog medija
c. mogucnost percepcije mehanickih valova
d. sve gore navedeno

Nakon stvaranja, zvucni valovi moraju se kretati kroz

da bi dosli do prijemnika zvuka.

Povezite pojmove:
Visina, jacina, boja i trajanje

frekvencija zvuka
zvuka.

Broj mehanickih valova u nekoj

jacina zvuka R
jedinici vremena.

ton zvuka Subjektivni intenzitet zvuka (dB).

Nacrtajte zvuéni val slabijeg i jateg intenziteta.

Slijed digitalnih podataka pohranjenih na raunalu moze se

reproducirati pomocu . Osoba iste

vibracije u zraku moZze proizvesti koristeci

prima zvuéne valove i pretvara ih u

elektricnu energiju koja se nakon pretvaranja u digitalne

vrijednosti na nekom digitalnom

mediju.
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2. Instalacija Audacityja, upoznavanje s
radnim prostorom i snimanje zvuka

Po zavrSetku ovog poglavlja polaznik ¢e moci:

e spojiti mikrofon i sluSalice na racunalo

o testirati rad mikrofona i slusalica

e  Koristiti se mikrofonom za snimanje u Audacityju
e  navesti mogucnosti obrade zvuka

e  prepoznati dijelove sucelja programa Audacity.

Snimanje zvuka ukljuCuje registriranje zvuénih valova koji se stvaraju
glasom (neartikulirani zvukovi, govor, pjevanje), glazbenim
instrumentima ili prirodnim pojavama i njihovo spremanje na medij za
pohranu, koriste¢i racunalni program za snimanje zvuka.

Danas se svakodnevno i jednostavno koristimo uredajima za snimanje
zvuka, pametnim telefonima, nesvjesni njihove kompleksnosti i razvoja
dugog 200 godina. Povijest snimanja zvuka pocinje s akusticChom
erom, proteze se kroz elektri¢nu i magnetsku eru, sve do digitalne ere
u kojoj se nalazimo danas. Digitalne tehnologije znatno
pojednostavljuju i proSiruju mogucénosti obrade i koristenja zvuka.
Snimanije, distribucija i prijenos zvuka veéem broju korisnika, na velike
udaljenosti i u kratkom vremenu, ucinili su snimanje i prijenos zvuka
nezamjenjivim alatom naSe svakodnevnice.

Proces snimanja podrazumijeva mehanicko registriranje zvuénih
valova membranom mikrofona koja pomic¢e magnet u zavojnici. Takvo
gibanje proizvodi elektricnu energiju koja se vodi¢em prenosi do
analogno-digitalnog pretvornika koji pretvara analogne signale u slijed
digitalnih vrijednosti koje se mogu poslati ili pohraniti na mediju.

Za snimanje zvuka na ragunalo potrebno je spojiti mikrofon i instalirati
odgovarajuci racunalni program. Postoji mnogo komercijalnih i
besplatnih programa za snimanje i obradu zvuka, od profesionalnih koji
imaju napredne mogucnosti, do amaterskih u kojima se moze brzo i
lagano napraviti osnovna obrada zvuka. Programi za obradu zvuka
omogucuju snimanje, obradu i proizvodnju zvuka te se mogu instalirati
na racunalu ili koristiti kao web-aplikacija.

U ovom poglavlju objasnjeno je kako se mikrofon ispravno spaja na
racunalo te kako se instalira i koristi program Audacity koji se ne
razlikuju mnogo od komercijalnih alata, tako da moze posluziti i
naprednijim korisnicima, a zbog toga $to je besplatan i jednostavan za
koriStenje izvrstan je alat i za neprofesionalne korisnike.
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2.1. Instalacijai pokretanje Audacityja

Kako bi se zvuk pohranio na racunalo potrebno je koristiti racunalni
program koji moze prepoznati digitalni signal koji dobije od mikrofona.

Uz vecinu operacijskih sustava instalira se i jednostavan program za
snimanje zvuka kojim se, pomocu osnovnih moguénosti, moze snimiti i
obraditi zvuk. Za naprednije moguénosti potrebno je instalirati
profesionalni program za snimanje i obradu zvuka kao $to je Audacity.

Za instalaciju Audacityja potrebno je preuzeti instalacijsku datoteku s
web-stranice http://audacityteam.org/. Nakon preuzimanja datoteke na
raCunalo, potrebno ju je pokrenuti i slijediti instalacijski postupak. Za
pokretanje programa u operacijskom sustavu Windows, odabere se
Start > Sve aplikacije > Audacity.

Za pokretanje Audacityja u operacijskim sustavima OS X i Linux,
odabere se Applications > Audacity.

2.2. Audacity i njegove mogucnosti

Audacity je besplatan program otvorenog koda za snimanje i obradu
zvuka koji je dostupan za operacijske sustave Windows, OS X i Linux.

Obrada zvuka koristi se za preklapanje naracije s pozadinskom
glazbom, uklanjanje ili izolaciju naracije, izradu petlje zvuka (engl.
loop), izradu tonova zvona, rezanje zvuénog zapisa na vise dijelova,
izvoz zvuCne datoteke koja se moze reproducirati na racunalu itd.
Neke od mogucénosti programa Audacity su:

e snimanje i reproduciranje zvuka

e uvoziizvoz razli¢itih formata zvuka

e obradivanje rezanjem, kopiranjem i lijepljenjem dijelova
zvuénog zapisa, tj. spajanje razli¢itih zvucnih zapisa

e preklapanje (mijeSanje) vise zvucnih zapisa

e dodavanje raznih efekata

e uklanjanje Sumova i buke

e ubrzavanje i usporavanje zvucnog zapisa

e postepeno smanjivanje i pojatavanje intenziteta zvuka
e dodavanje jeke

e imnoge druge.



http://audacityteam.org/
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2.3. Radno sucelje

Pri otvaranju Audacityja prikazuje se radno sucelje s mogucénostima
obrade i prikazom zvuénog zapisa.

Radno sucelje Audacityja sastoji se od 3 dijela:

1. glavnog izbornika koji sadrzi popis mogucnosti programa
slozenih u padajuce izbornike

2. alatne trake koje omoguéavaju brz pristup mnogim
mogucnostima

3. zvucnih zapisa koji prikazuju snimljeni ili uvezeni zvuk.

dows WaS: -, Speskers (Reshek High Defi 2 iSteves) Recon -~ uf) Speskers (Reakek High Def ~~
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e i _elect dew Tonmut_TwcksGenente oo 11—
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. + s [
"

Glavni izbornik i prikaz zvuénih zapisa nepomicni su, dok se po potrebi
alatne trake radi lakSeg koristenja mogu premjestati. Za premjestanje
alatne trake odabere se njezin krajnji lijevi dio i traka se odvuce na
Zeljenu poziciju. Ako se Zele resetirati alatne trake na pocetnu poziciju,
potrebno je oti¢i na izbornik View - Toolbars - Reset Toolbars.
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2.4. Spajanje mikrofona i slusalica na racunalo

Na gotovo svakom stolnom rac¢unalu nalazi se priklju¢ak za mikrofon i
sludalice. Na novija prijenosna racunala ve¢ su ugradeni mikrofoni, dok
svaki pametni telefon ima mikrofon i opciju za snimanje.

Na racunalo je moguce spojiti mikrofon, sluSalice ili druge audio
uredaje koristedi prikljucke za zvuk koji se nalaze na prednjoj, straznjoj
ili bo€noj strani racunala.

Standardni priklju€ci koje koristimo za snimanje i reprodukciju zvuka
su:

e priklju¢ak za mikrofon — ruziCaste boje

e priklju¢ak za razne audio-uredaje (mp3 player, glazbeni
instrumenti, mjesSaci zvuka — miksete, dodatni mikrofon...) —
plave boje

e priklju¢ak za zvuénike — zelene boje.

Alternativni nadin spajanja audio-uredaja na ra¢unalo je putem USB-
prikljucka.

2.5. Kontrole intenziteta zvuka pri snimanju i
reprodukciji

Alatna traka Mixer Toolbar ima mogucénosti pojacavanja i smanjivanja
inteziteta zvuka pri snimanju (lijevi kliza€) i reprodukciji (desni klizac).

\!}— ﬁ+‘a— o +

° (@ srce
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2.6. Testiranje rada mikrofona

Prije pokretanja programa i testiranja rada mikrofona potrebno je
ispravno umetnuti priklju¢ak mikrofona u racunalo i konfigurirati
operacijski sustav da prepozna mikrofon (konfiguracija je razli¢ita u
svakom operacijskom sustavu).

Za testiranje rada mikrofona potrebno je:

1. Odabrati spojeni mikrofon iz izbornika Recording Device iz
alatne trake Device (ako se mikrofon ne pojavljuje u izborniku,
potrebno je u operacijskom sustavu provijeriti je li ispravno
instaliran i spojen na ra¢unalo).

Windows W \!/ Microphone (Realtek High C -~ |?_(Stereo) Record ‘D Speakers (Realtek High Defir

2. Kiliknuti ljevom tipkom misa na tekst Click to Start Monitoring
unutar alatne trake Recording Meter Toolbar kako bi se pratio
signal koji Audacity prima preko mikrofona.

i

. . . . .
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3. Prva slika prikazuje izgled alatne trake kada zvucni signal nije
dovoljno intenzivan. U ovom sluc€aju potrebno je glasnije
govoriti, provjeriti ispravnost mikrofona ili pomaknuti kliza¢ za
pojaCavanje intenziteta zvuka unutar alatne trake Mixer
Toolbar. Druga slika prikazuje optimalni intenzitet zvuka pri
snimanju, a zadnja slika jaci intenzitet zvuka.

i i ] g g i g i i
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2.7. Kontrole reprodukcije i snimanja

Koriste¢i alatnu traku Transport kontroliramo reproduciranje i snimanje
zvuénih zapisa.

] b | 14 > L _
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Za vise informacija o
podesavanju postavki
posjetite:

http://www.wikihow.com/C
onnect-Audio-Devices-to-
Computers



http://www.wikihow.com/Connect-Audio-Devices-to-Computers
http://www.wikihow.com/Connect-Audio-Devices-to-Computers
http://www.wikihow.com/Connect-Audio-Devices-to-Computers
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Mogucnosti reprodukcije su:
e Dugme Play " Koristi se za poCetak reproduciranja.

e Dugme Pause " Kkoristi se za pauziranje i ponovno pokretanje
reprodukcije ili snimanja. Reprodukcija ili snimanje nastavljaju
se na mjestu gdje su zaustavljeni.

e Za zaustavljanje reprodukcije ili snimanja potrebno je odabrati
Stop * . Nakon zaustavljanja, zvucni se zapis reproducira od
pocetka.

e Skip to start * i Skip to end " premjeSta pokazivaC na
pocetak ili kraj zvu€nog zapisa.

e Za pocCetak snimanja odabire se dugme Record ° .

e Razmaknica na tipkovnici koristi se za poc€etak i zaustavljanje
reprodukcije ili snimanja.

Prije poCetka obrade zvuka, reprodukcija ili snimanje moraju biti
zaustavljeni odabirom dugmeta Stop.

2.8. Snimanje zvuka u Audacityju

Nakon testiranja rada mikrofona, koraci za snimanje su:

1. Odabirom dugmeta Record iz alatne trake Transport pokrece
se snimanje.

I > n I« 4! ®

2. Za pauziranje shimanje odabire se Pause, dok se za potpuno
zaustavljanje snimanja odabire Stop.

I > u 14 4! @

3. Snimljeni zvuk prikazuje se u srediSnjem dijelu suCelja kao
zvulni zapis.

NEAMT/ T it [
M AT YT P 0

BT Mt bl s AN
MO TEE Y Y O

4. Zvucni zapis reproducira se odabirom dugmeta Play.

I .3 M 14 ! [
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2.9.

o & 0D

Vjezba: Spajanje mikrofona i slusalica na
racunalo i snimanje zvuka

Ako imate otvoren Audacity, zatvorite ga bez spremanja
datoteke projekta.

Spoijite mikrofon i sluSalice na racunalo.
Otvorite Audacity.
Testirajte ispravnost mikrofona.

Snimite sljededi tekst: ,Audacity je besplatan program
otvorenog koda za snimanje i obradu zvuka, a dostupan je za
operacijske sustave Windows, OS X i Linux. Audacity se moze
koristiti za preklapanje naracije s pozadinskom glazbom,
uklanjanje ili izoliranje naracije, izradu petlje zvuka (engl. loop),
izradu tonova zvona mobilnog telefona, izvoz zvuéne datoteke
koja se moze reproducirati na racunalu, rezanje zvuénog zapisa
na viSe zvuénih zapisa.”

Odaberite dugme Stop za zaustavljanje snimanja.
PresluSajte snimljeni zvuk.
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3. Uvoziizvoz zvuénih datoteka,
spremanje projekta

Po zavrSetku ovog poglavlja polaznik ¢e moci:

e uvesti zvuénu datoteku

e  razlikovati razli¢ite formate zvuénih datoteka
e izvesti razli¢ite formate zvuénih datoteka

e  spremiti projekt.

Zvucni format je datoteCni format koji se koristi za spremanje digitalnog
zvuka na racunalnim sustavima, dok se sva obrada u Audacityju
sprema kao projekt u datotenom formatu .aup3.

Formati koji se mogu uvesti u Audacity su:
¢ nekomprimirane zvuéne datoteke WAV i AIFF

e komprimirane zvuéne datoteke Ogg Vorbis, FLAC, MP2 i MP3.

Nekomprimirane zvuéne datoteke sadrze originalnu kvalitetu zvuka
koja je dobivena prilikom snimanja. Kako bi se dobile zvu¢ne datoteke
manije veli€ine, zvuéni se zapis komprimira, ¢ime se gubi kvaliteta
zvuka.

Za koristenje dodatnih formata zvu¢nih datoteka (MP3, AC3, AMR(NB),
M4A, MP4 i WMA) potrebno je instalirati uvozno-izvoznu knjiznicu
LAME MP3 encoder i FFmpeg import/export library. Za instalaciju
knjiznice potrebno je preuzeti datoteku s Interneta
(http://audacityteam.org/download/windows) i instalirati je na racunalo.

3.1. Uvoz zvuénih datoteka

Za uvoz datoteke:

1. Odabire se izbornik File - Import > Audio.

gAudacity
File Edit S5elect View Transport Tracks Generate Effect  Analy:
Mew Ctrl+ N I =
b P r ey
Open... Ctrl+Q
i Qe
Recent Files »
Close Ctrle W Realtek High C ~ 2 (Sterec) Record ~
1.0 2.0 3
Save Project » L L 1 . 1
Export b
Import ¥ Audio... Ctrl+Shift+I
PrraEi. Lakels...
Print... DL
Raw Data...
Exit Ctrl+
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2. Pojavljuje se dijaloski okvir Select one or more audio files... u
kojem se prikazuje struktura mapa i podmapa na racunalu. Kad
se pronade, odabere se Zeljena zvu€na datoteka i pritisne se

dugme Open.

€ Select one or more files X
Look in \ Vjezbe v| @ ¥ o m-
* Name - Date modified Type Size
Projekt1_data 22.4.2016.11:41 File folder
Quick access Projekt?_data 2242016 11:41 File folder
Projekt3_data 2242016, 11:41 File folder
- Projektd_data 22.4.2016.11:41 File folder
Desktop Rjesenje_5_3_data 2842016, 15:06 File folder
- Vjezba_7-1 2242016, 11:41 File folder
(] Vjezba_7-2 2242016, 1141 File folder
Libraries Vjezha_7-3 22.4.2016. 11:41 File folder
naracijamp3 22.1.2016.11:17 MP3 File 1560 KB
L] | ! Pozadinska. glazba.mps 21.12.2015. 1617 MP3 File 5928 KB |
This PC F¥Projekt T aup 7212076, 10:45 iy Project o
Projekt!.mp3 2742016, 16:34 MP3 File 7447 KB
§ EProjert2.aup 221.2016.10:52 Audacity Project .. 24K8
Network EProjektZ.aup 221.2016. 11:06 Audacity Project F... 13KB
EProjektd.aup 221.2016.11:12 Audacity Project F.. 13KB
O Rjesenje 5_3.aup 28.4.2016.15:06 Audacity Project F.. 14KB
Vjezba_7-1.mp3 1842016, 13:22 MP3 File 946 KB
Vjezha_T-2.mp3 18.4.2016. 13:23 MP3 File 966 KB
Vjezba_7-3.mp3 1842016, 13:23 MP3 File 690 KB
il name: pozadinska_alazba mp3 «]  |L_open
Fies of type Alfies - Cancel

3. Nakon odabira, zvu¢na se datoteka prikazuje u sredisnjem

duelu sucelja.
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Alternativni nacin uvoza datoteke jest koristenjem mogucnosti Povuci i

ispusti (Drag&Drop) kao $to je prikazano na slici.

Projekt]_dat
Projekt2_data
Projeki3_data
Projektd_data
Riesenje_5_3_data
Viezba_7-1
Vjezba_7-2
Vjezba_7-3

naracija.mp3

Bez obzira na koji nacin uvezemo
zvu€nu datoteku, ona se uvijek prikazuje
kao novi zvuc€ni zapis u srediSnjem dijelu
sucelja.

Moguce je uvesti viSe zvuénih datoteka
koje ¢e u srediSnjem dijelu sucelja biti
jedna ispod druge i simultano ¢e se
reproducirati.

& Projekti.\up
Projektl.m)

& Projekt2.aup
& Projekt3.aup
& Projektd.aup
& Rjesenje_5_2aup
Vjezba_7-1.mp3

Vjezba 7-2.mp3
Vjezba_7-3.mp3

& Audacity

File Edit Select View Tansport Tacks Generate |
n [ 2 ] I« »l [ ]

$ o) Lo z
Windows W | & ' Microphone (Reatek High T | 2 (ste

E - 1‘.0 di,? 1‘.0 ZI.D
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Nakon uvoza, zvu¢na datoteka je spremna za reprodukciju, obradu,
dodavanije efekata itd.

3.2. Stvaranjei spremanje projekta

Sva obrada zvuénih zapisa u Audacityju sprema se kao projekt. Tako
spremljen projekt mozZe se naknadno otvoriti i uredivati.

& Audacity
File Edit Select View Transport Tracks Generate Effect  Analy:
[ mew Ctrl+N 1=
b o -
Open... Ctrl+ 0 a
b Q| e:
Recent Files » =
| Close Carle W Realtek High C ~ || 2 (Stereo) Record ~
Save Project » Save Project Ctrl+5
Export » Save Project As...
Import 5 Backup Project...
Page Setup...
Print...
Exit Ctrl+Q

Za stvaranje novog projekta iz izbornika File potrebno je odabrati New,
a za spremanje projekta potrebno je iz izbornika File odabrati Save
Project As.... Projekt se moze i zatvoriti odabirom Close iz izbornika
File.

Projekt napravljen u Audacityju sastoji se od jedne datoteke s
datote¢nim nastavkom AUP3.

3.3. lzvoz zvucnih datoteka

Projekt spremljen u Audacityju ima datote¢ni nastavak .aup3 i datoteku
je moguce otvoriti samo tim programom. Zbog toga je potrebno projekt
izvesti, tj. zvucni zapis spremiti kao datoteku koja se moze koristiti u
raznim programima i uredajima za reprodukciju glazbe. Audacity moze
izvesti zvuéne datoteke s datote¢nim nastavcima WAV, AlIFF, MP3,
FLAC, Ogg Vorbis i mnogim drugim.

Za izvoz datoteke potrebno je:

1. Odabrati naredbu Export Audio iz izbornika File > Export (za
izvoz oznagenog dijela zvuénog zapisa odabire se naredba
Export Selected Audio) ili odmah odabrati izvoz u jedan od tri
najcesc¢e koristena formata za izvoz (MP3, WAV, OGG).

3 pozadinska_glazba
File Edit Select View Transport Tracks Generate Effect Analyze Tools |

New CtrlsN 1=/ 4
b [ ]
Dpen.. Ctrls0 Q -
Lk SEE
Recent Files >
— Cutey  [Realtek High € |2 (Stereo) Record |} [Speal
15 30 5 10
Save Project L | | .
Export > Export as MP3
Import > Export as WAV
Page Setup.. Export as 0GG
e | Export Audio... CrlsShift-£ |
Export Selected Audio...
(e Ea Export Labels...
1.0 Export Multiple... Ctrls Shift+L
ol Export MIDI...
i
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2. U strukturi mapa i podmapa na racunalu, koja se prikazuje u

dijaloS8kom okviru Export Audio, odabrati mapu u koju ¢e se
izvesti datoteka.

r N
@ Export Audio ==
Savein: | Projekti - @ E
- Name Date modified Type
=l Mo iters match your search,
Recent Places
Desktap
Libraries
LY
Computer
t a n ] »
=) File name: izvoz - Save
Neterk Lo ]
Saveastpe: WAV (Microsoht) signed 160t PCM - [ canesl |

3. Odabrati Zeljeni datoteCni nastavak iz padajuceg izbornika Save

as type.

4. U tekstualni okvir File name upisati naziv datoteke i odabrati

dugme Save.

- S
@ Export Audio ||
Savein: | Projekli - oo
I Name Date modified Type
E No items match your search
Recent Places
Desktop
Libraries
A
Computer
@ o i ] v
Fi name izvoz - Save
Network
Save as type | WAV (Microsoft) signed 165t PCM -] | [ Cancel |
T
WAV (Vicrosoft) signed 16t FCM Options
WAV (Vicrosoft) 32 float PCM

Other uncompressed files

Ogg Vorbis Files %
FLAC Files

WMP2 Files

{extemal program)

W47 (AAC) Files (FFmpeg)

AC3 Fies (FFmpeg)

AMR fnamow band) Files [FFmpeg)

VIMA (version 2) Files (FFmpeg)

Custom FFmpeg Export

s N
@ Export Audio [
Savein: || Projekti - @ rE
= Mame - Date modified Type
""-.9 Mo items match your search.
Recent Places
Desktop
Libraries
TV
Computer
i < [0 | r
L =4 Filz name: | izvoz - | -m
Network
Save as type: [MFH Files - I Cancel ]
\
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3.4. Vjezba: Uvoz datoteke, kontroliranje
reprodukcije i snimanja, spremanje projekta

1. Otvorite Audacity.
2.  Snimite sljedeci tekst:
< Pauza oko 5 sekundi. >

»LAudacity je besplatan program otvorenog koda za snimanje i
obradu zvuka koji je dostupan za operacijske sustave Windows,
OS Xi Linux.*

< Pauza oko 5 sekundi. >

~LAudacity se moze koristiti za preklapanje naracije s
pozadinskom glazbom, izolaciju ili uklanjanje naracije, izradu
petlje zvuka, izradu tonova zvona, izvoz zvuéne datoteke koja
se moze reproducirati na raCunalu, rezanje zvu¢nog zapisa na
vide isjeCaka te spajanja dijelova zvu¢nih zapisa.”

< Pauza oko 5 sekundi. >

»,Bez obzira na koji nacin uvezemo zvucnu datoteku, ona se
uvijek prikazuje kao novi zvuéni zapis u sredidnjem dijelu
sucelja.”

< Pauza oko 5 sekundi. >

»,Neke od moguénosti ovog programa su: snimanje i
reproduciranje zvuka, uvoz i izvoz razli¢itih formata zvuka,
obradivanje rezanjem, kopiranjem i lijepljenjem dijelova
zvuénog zapisa, tj. spajanje razli€itih zvucnih zapisa,
preklapanje vise zvu€nih zapisa, dodavanje raznih efekata,
uklanjanje Sumova i buke, ubrzavanje i usporavanje zvu¢énog
zapisa, postupno smanjivanje i pojaavanje intenziteta zvuka,
dodavanje jeke i mnoge druge.”

< Pauza oko 5 sekundi. >

3. PresluSajte svoju snimku (pritisnite dugme Play), pauzirajte
reprodukciju na dijelu naracije ,Bez obzira...“ dugmetom Pause.

ZapiSite u kojoj ste minuti i sekundi zaustavili zvucni zapis:

4. Dugmetom Stop ponistite pauzu reprodukcije kako bi mogli
nastaviti uredivati zvucni zapis.

5. Uvezite zvuCnu datoteku pozadinska_glazba.mp3 iz mape
Vjezbe.
Izvor: Drops of H20 ( The Filtered Water Treatment ) by J.Lang (c) 2012 Licensed under a

Creative Commons Attribution (3.0) license. http://ccmixter.org/files/djlang59/37792 Ft:
Airtone
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Spremite projekt pod nazivom Projektl.aup3 u mapu Projekti
(spremljeni projekt koristit ¢e se u sljedecoj vjezbi).

PresluSajte kako se naracija preklapa sa uvezenom zvuénom
datotekom i napiSite svoj prijedlog daljnje obrade.

Izvezite zvucne datoteke formata MP3, Ogg Vorbis i WAV (WAV
(Microsoft) 32-bit float PCM) s imenima ,mp3_zvuk®,
,09g_vorbis_zvuk® i ,wav_zvuk, u mapu Projekti.

ZapiSite veli€inu pojedine datoteke u MB:

e  mp3_zvuk.mps3:

e 0gg_vorbis_zvuk.ogg:

e wav_zvuk.wav:

Otvorite datoteku mp3_zvuk.mp3 u programu Windows Media
Player.

20
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4.0snovna obrada zvuénog zapisa

Po zavrSetku ovog poglavlja polaznik ¢e moci:
e upotrijebiti alate za promjenu prikaza zvuénog zapisa
e oznaciti dijelove ili cijeli zvuéni zapis

. izrezati, kopirati, obrezati i obrisati zvucni zapis.

Prije digitalne ere, obrada zvuka vrdila se pomocu Zileta i ljepljive trake.
Magnetska traka bi se rezala i ljepila na drugu ili uklanjala po potrebi.
Mnoge tehnike i izrazi koji su se koristili u proslim erama obrade zvuka
koriste se danas i dobra su podloga za izradu programa za obradu
zvuka.

Razvojem tehnologije racunala zamjenjuju strojeve za magnetske
trake, digitalni dokumenti magnetske trake, a racunalni programi
automatiziraju vecéinu procesa koji su se morali obavljati ruéno. Tako
Covjek snima i obraduje zvuk racunalom, §to cijeli proces €ini brzim,
jednostavnijim i zauzima manje fiziCkog prostora.

Kako bi se odredeni dio zvuka pravilno obradio pomodu rezanja,
lijepljenja, premjestanja i sl., potrebno ga je pravilno prikazati i oznaciti.
Prikaz, ozna€avanje zvuénog zapisa i rezanje najkoristeniji su alati za
obradu zvuka, a ujedno i teme ovog poglavija.

4.1. Prikaz zvu€énog zapisa

Jedna traka predstavlja jedan izvor zvuka u cjelokupnom zvu¢nom
zapisu. Moguce je dodavati ili snimiti viSse zvu€nih zapisa kao $sto
postoji viSe instrumenata u glazbenom sastavu koji se medusobno
preklapaju.
Svaki prikaz zvu€nog zapisa sadrzi:

A. plo€u s postavkama zvu€nog zapisa
B. vertikalnu skalu s jedinicama
C. vizualni prikaz valnog oblika.

VTR T

L WWMWMWmmmwmmmMmummunMW;UMM{WWMMu,\mmLuMhWM
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Nova traka stvara se svaki put pri umetanju nove zvucne datoteke ili
snimanju zvuka. Takoder se moze dodati nova prazna traka, mono ili
stereo, odabirom Mono Track ili Stereo Track iz izbornika Tracks -
Add New.

Stereo je reprodukcija ili snimanje zvuka koristenjem dva ili vise
neovisna zvu¢na kanala (kao na slici ispod), dok se mono zvuéni zapis
koristi samo jednim zvu¢nim kanalom. Lijevi kanal stereo zvuénog
zapisa nalazi se na gornjem dijelu zvuénog zapisa, a desni kanal na
donjem dijelu.
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Donja traka zvu€nog zapisa prikazuje mono zvuéni zapis, gdje se isti
zvuk reproducira na lijevom i desnom kanalu zvuénika.

Ako zvucni prikaz dodiruje i gornji i donji dio trake, zvuk ima jaci
intenzitet i obratno.

Svaka zvuéna traka moZe se pomicati po vremenskoj liniji, tj. moze joj
se odrediti vrijeme pocetka reprodukcije. Ravnalo iznad traka zvuka
prikazuje duzinu zvuénog zapisa u minutama i sekundama.

Pojedine zvucne trake mogu se zatvoriti odabirom dugmeta X unutar
plo¢e s postavkama zvuénog zapisa.
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4.2. Poveéavanje i smanjivanje prikaza zvu¢nog
zapisa

Za detaljniju obradu dijelova zvuénog zapisa ili pregledavanje cijelog
projekta ili zvuénog zapisa koriste se alati za povecavanje i
smanjivanje prikaza zvu€nog zapisa. Spomenuti alati ne vrSe obradu
zvuka, ve¢ mijenjaju njegov prikaz u svrhu jednostavnije obrade.

Povecanje i smanjivanje prikaza pomocu alatne trake Edit

Za pregledavanje cijelog zvu¢nog zapisa ili samo jednog dijela koriste
se alati za uve€avanje i smanjivanje unutar alatne trake Edit.

XD mwr | &R QI

Za smanijivanje prikaza, kako bi se prikazao cijeli zvuéni zapis, Kkoristi
se dugme Zoom Out </ slika ispod prikazuje cijeli zvucni zapis koji
traje pet minuta i 15 sekundi. Trajanje prikazanog dijela zvu¢nog
zapisa moze se vidjeti na vremenskoj liniji iznad njega.

0 345 400 415 0 45 00 515 530 545

.........

WWWMW sl mﬂh il

. "WWWW" R L
el A 1l

Za uvectavanje prikaza zvu¢nog zapisa, kako bi se vidjeli detalji, koristi

se dugme Zoom In E . Na slici ispod prikazan je isti zvu¢ni zapis, ali
uvecan pa se vidi samo isje¢ak od 2. minute i 13. sekunde do 2.
minute i 55. sekunde.

v 1140 1150 160 1470 1180

R [pozadnataw 10
e | Sol
o
L "

°
res sst00mz
Sieon toat

a| sec

Povecéanje i smanjivanje prikaza pomoc¢u izbornika View

iew Tapsport Tacks Generate Effect Analyze Tools Help

Spomenute i dodatne moguénosti

Zoom > Zoom In Ctle1 |

S pripadajuéim preéacima mogu 'Srr:ckiwza > Zoom Normal Ctrl+2
. i . . ip to > Zoom Out Ctrl+3
se odabrati i u izborniku View =2 . Zsom o Selecton o+t
U e Zoom Toggle Shift-Z

ZOO m . Mixer Board... Advance: d Vertical Zoomin: q
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NAPOMENA

Za vise informacija o
oznacavanju posjetite:

http://manual.audacitytea

m.org/o/man/audacity se
lection.html.

Povecéanje i smanjivanje prikaza pomoc¢u dugmeta Zoom Tool

Povecanje i smanjenje prikaza zvu¢nog zapisa moguce je i i-? Ve
odabirom dugmeta Zoom Tool Q iz alatne trake Tools. Q |H X

Za povecavanje prikaza potrebno je postaviti strelicu miSa iznad
zvuc€nog zapisa i pritisnuti lijevu tipku misa, a za smanjivanje desnu
tipku misa.

Odredeni dio zvuénog zapisa moguce je povecati i alatom Zoom Tool
tako da se lijevom tipkom miSa klikne na traku, i bez pustanja lijeve
tipke miSa strelica se odvuce do Zeljene pozicije (za smanjivanje drzi
se i tipka [Shift]). Na slici ispod moZe se vidjeti pocetak (lijeva
isprekidana crta) i kraj dijela zvu€nog zapisa koji Ce se povecati (desna
isprekidana crta sa strelicom u obliku povecala).

% e v 18
o

Povecanje i smanjivanje prikaza pomocu tipke [Ctrl] i kotai¢a
misa

Prikaz zvu¢énog zapisa moguce je povecati ili smanijiti tako da se
strelica miSa smjesti na zvuéni zapis, zatim se pritisne tipka [Ctrl], a
kotacCi¢ misa okrecCe se prema gore kako bi se prikaz zapisa povecao ili
prema dolje kako bi se prikaz zapisa smanijio.

4.3. Ozna€avanje dijelova zvuénog zapisa

Kako bi se alati za obradu zvuka mogli primijeniti, u Audacityju je
potrebno oznaciti dio zvu€ne trake ili pak cijelu zvu€nu traku, a
ponekad je potrebno oznaditi i vise zvuénih traka. Oznaceni dijelovi
mogu se premjestati, brisati, rezati ili se na njih mogu primijeniti efekti.

Za oznacavanje odredenog dijela zvu€nog zapisa potrebno je odabrati

alat Selection Tool I iz alatne trake Tools. Alatom Selection Tool
odabere se poCetna to¢ka zvucnog zapisa koji se zeli oznaditi, a zatim
se strelica miSa odvuce na lijevu ili desnu stranu do Zeljene krajnje
tocke odabira. Oznaceni dio bit ¢e tamnije boje od ostatka zvu¢nog
zapisa, kako je prikazano na slici ispod.
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Za poniStavanje odabranog dijela, potrebno je kliknuti bilo koji dio
zvucénog zapisa lijevim klikom misa ili odabirom opcije None iz
izbornika Selecet - None.

Cijela traka moze se oznaciti odabirom sive povrSine plo¢e s
postavkama zvuénog zapisa, a sve trake moguce je odabrati odabirom
opcije All iz izbornika Select > All.

Oznaceni dio zvuénog zapisa reproducira se odabirom dugmeta Play,
a za ponovno reproduciranje cijelog zvuénog zapisa potrebno je
ponistiti odabrani dio.

Za povecavanije ili smanjivanje oznaenog dijela zvuénog zapisa
odabere se njegov rub. Kada se strelica miSa pretvori u ruku
ispruzenog kaziprsta, zvuéni se zapis povlaci u Zeljenom smjeru kako
bi se oznaceni dio povecao ili smanjio.

7| 180 19.0 200 270 220 230 240 250 260 710 280 , B0 300 310 320 30

ooy 13
s | son
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Detaljnije mijenjanje pocCetka i kraja ozna¢enog dijela moguce je unutar
alatne trake Selection, upisivanje to€nog vremena pod Selection Start
i End, kao $to je prikazano sa slici ispod. |z alatne trake Selection u
prozoru Audio Position moguce je vidjeti trenutnu vrijeme
reprodukcije, ozna¢eno zadnjim crvenim okvirom na donjoj slici (26
sekundi).

Project Rate (Hz) | Snap-To | Start and End of Selection w

[ ]jor  |[[conoom2s 7515 Joonoom2s 7515y 0O0hOO0Om26 s
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4.4. lzrezivanje, kopiranje, obrezivanje i brisanje
zvucénog zapisa

Izrezivanje, kopiranje, obrezivanje i brisanje najéed¢e su naredbe za
obradu zvuka.

Nakon oznaCavanja, Zeljeni dio zvu€nog zapisa moze se izrezivati,
kopirati, obrezivati i brisati. Spomenute mogucnosti dostupne su u
izborniku Edit i alatnoj traci Edit.

KOO wa =~ &QQQ

e Cut K uklanja oznaceni dio trake i smjeSta ga u
meduspremnik kako bi se zalijepio na drugu traku ili u drugi
projekt.

Na mjestu gdje ¢e se zalijepiti izrezani dio trake potrebno je

postaviti Selection Tool I j odabrati naredbu Paste |j iz
izbornika Edit ili iz alatne trake Edit.

e Copy |_|:| ostavlja oznaceni dio trake na mjestu i smjesta
njegovu kopiju u meduspremnik kako bi se zalijepio na drugu
traku ili u drugi projekt.

Na mjestu gdje Ce se zalijepiti kopirani dio trake potrebno je

postaviti Selection Tool I j odabrati naredbu Paste E] iz
izbornika Edit ili iz alatne trake Edit.

e Trim Audio " brige dio zvugne trake koji je ispred i iza
oznacenog dijela zvu¢nog zapisa.

e Silence Audio " oznageni dio trake pretvara u tiSinu.

e Delete iz izbornika Edit ili tipka [Delete] na tipkovnici uklanjaju
oznaceni dio trake.

4.5 Brisanje i vra¢anje zadnje akcije

Naredba Undo *™ brie posljednju primijenjenu naredbu. Moguce je
vratiti svaku akciju od poCetka otvaranja projekta, a popis sa svim
akcijama nalazi se u izborniku View - History.

Odabirom naredbe Redo “™ ponistava se brisanje, tj. vracanje akcije.

Obje naredbe dostupne su u izbornika Edit i alatnoj traci Edit.

KOO i |~ @& QQ
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4.6

Vjezba: Osnovna obrada zvuka

Otvorite projekt Projektl.aup3 koji ste samostalno izradili u
prethodnoj vjezbi i spremili u mapu Projekti.

Ako nemate spomenutu vjezbu, koristite se projektom
Projektl.aup3 koji se nalazi u mapi Vjezbe.

Kako nam pozadinska glazba ne bi smetala pri obradi naracije,
potrebno ju je u potpunosti stisati.

Odaberite opciju Mute na ploci s postavkama zvu€nog zapisa
(lijevo od prikaza zvuénog zapisa) pozadinske glazbe kako bi
potpuno stiSali pozadinsku glazbu.

Oznacite dio naracije: “Audacity se moze Koristiti za preklapanje
naracije s pozadinskom glazbom, izolaciju ili uklanjanje
naracije, izradu petlje zvuka, izradu tonova zvona, izvoz zvuéne
datoteke koja se moze reproducirati na raéunalu, rezanje
zvu€nog zapisa na viSe zvuénih zapisa.”

Oznaceni dio naracije izrezite i zalijepite na kraj zvu€ne trake.

Oznadite i izbriite dio naracije ,Bez obzira na koji nacin
uvezemo zvucénu datoteku, ona se uvijek prikazuje kao novi
zvuCni zapis u srediSnjem dijelu sucelja.” koriste¢i naredbu
Delete.

Smanijite vremenski razmak izmedu odlomaka sa pet sekundi
na dvije sekunde koristec¢i naredbu Delete.

Pretvorite vremenski razmak izmedu odlomaka u tiSinu koristeci
naredbu Silence Audio.

Odaberite opciju Mute na plo€i s postavkama zvu¢nog zapisa
(lijevo od prikaza zvuénog zapisa) pozadinske glazbe kako bi
ponovno uklju€ili pozadinsku glazbu.

Spremite projekt pod nazivom Projekt2.aup3 u mapu Projekti.
Spremljeni projekt koristit ¢e se u sljedecoj vjezbi.
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5. Napredna obrada zvuénog zapisa

Po zavrSetku ovog poglavlja polaznik ¢e moci:
e  stvarati i uredivati isjeCke
e upotrijebiti alate za smanjivanje i pojadanje intenziteta zvuka.

IsjeCci se koriste za rezanje dijelova naracije i premjestanje dijelova
govora, u izradi petlji ili premjeStanju dijelova trake na druge trake zbog
lak§e manipulacije zvu¢nog zapisa.

PojaCanje i smanjivanje zvuka jedan je od vaznijih alata obrade zvuka.
Koristi se za lagane prijelaze zvuka iz tiSine ili u tiSinu, za uskladivanje
naracije i pozadinske glazbe ili miksanje.

5.1. Isjecci

Kada se zvucna datoteka uveze u Audacity, ona je neprekinuta (prva
traka na slici ispod). Svaka neprekinuta traka moze se razdijeliti u
isjeCke (druga traka na slici) kako bi se zvuénim zapisom moglo lak3e
manipulirati. Svaki isje€ak mozZe se pomicati neovisno o drugim
isje€cima.
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5.1.1. Dijeljenje traka u isjecke
Postoji nekoliko nagina dijeljenja neprekinutih traka u isje¢ke:

e naredba Edit > Clip Boundaries = Split razdvaja isje€ak ili
cijelu traku tamo gdje je oznacena alatom Selection Tool.

¢ naredba Edit > Remove Special > Split Cut briSe oznaceni
dio trake, a od neoznacenih dijelova stvore se dva isjecka.
Obrisani isjeCak sprema se u meduspremnik i moze se
zalijepiti na istu ili drugu traku.

e naredba Edit > Paste prethodno izrezani ili kopirani dio trake
zalijepi kao novi isje€ak.
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5.1.2. Spajanje isjeCaka

Dva isjeCka mogu se spojiti odabirom linije (prikazano na slici ispod)
koja ih razdvaja dok su smjesteni jedan do drugog.

| pezmingta ¥ 1.0
bate | Som

o
Sree, 41001
3200 ot

i il i
Tl T T

[T [ WL RET™

Alternativno, isjecci se mogu spojiti tako da se oznace alatom Selection
Tool, a zatim se odabere naredba Join iz izbornika Edit = Clip
Boundaries.

5.1.3. Premjestanje zvucnih isjecaka

. . —_
Za premjestanje isjeCaka koristi se alat Time Shift Tool - IT A ﬁ
koji se nalazi u alatnoj traci Tools. Qe ﬂ

Nakon odabira isje¢ka alatom Time Shift Tool, potrebno je kliknuti
ljevom tipkom mi8a na Zeljeni isje€ak i drzeci lijevu tipku misa
premjestiti ga lijevo ili desno. Na isti nacin isje€ci se mogu premjestati
iz jedne trake u drugu.

5.2. StiSavanje i poja¢anje intenziteta zvuka

Intenzitet zvuka moze se mijenjati za cijelu zvuénu traku ili po
pojedinim segmentima. Preko ploCe s postavkama mijenja se intenzitet
zvuka za cijelu traku, dok se za pojedine segmente koriste alati
Envelope Tool i Selection Tool.

5.2.1. Ploc¢a s postavkama zvuénog zapisa

Postavke pojedinane zvuéne trake nalaze se pokraj vizualnog prikaza
zvu€nog zapisa (oznaceni dio na slici ispod).

| pozadinska_w/|| 1.
Wute | Solo
= +
g

L R

g
Stereo, 44100Hz
32-oit float

A Select
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Neke od mogucnosti su:

e Gain Slider - klizatem se mozZe smanijiti i pojacati intenzitet
zvuka u odabranoj zvu€noj traci

e Pan Slider - klizatem se regulira raspodjela zvuka na lijevom i
desnom kanalu

e Ime - naziv zvuéne trake
¢ Mute - alat ¢e u potpunosti stiSati traku prilikom reprodukcije

e Solo - alat ¢e reproducirati trenutnu traku, a sve ostale u
potpunosti ¢e stidati.

5.2.2. Envelope Tool

Envelope Tool omoguéava postupnu promjenu intenziteta zvuka

. . . . —_
dodavanjem kontrolnih toc¢ki. Nakon odabira alata Envelope Tool =
iz alatne trake Tools, prikaze se tanka plava linija na vrhu i dnu valnog
oblika, kako je oznaceno na slici ispod.
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Za dodavanje kontrolne tocke potrebno je odabrati bilo koji dio plave
linije, nakon &ega ¢e se ona automatski pojaviti po vertikali zvuéne
trake (oznaceni dio na slici ispod).

| pozadinska_w| 1.0
Mute | soo .
] WMWW
L R
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Stereo, 44100Hz | g
32-bit float .

a| Ssekect 1.0
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Za povecanje intenziteta zvuka, kontrolna tocka premjesta se prema
gore, a za smanjivanje intenziteta prema dolje. Broj kontrolnih to¢aka
koje se mogu dodati na zvuéni zapis nije ograni¢en. Na slici ispod
prikazane su Cetiri kontrolne tocke koje smanjuju intenzitet zvuénog
zapisa i ponovo ga pojacavaju.

Ty
’lll'w LTI E A o BT S T T |I‘F"|l TRy

oo e o

| s

Za uklanjanje kontrolne toCke potrebno ju je odabrati i odvuci izvan
trake.
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5.3.

o g A w D

10.
11.

Vjezba: Napredna obrada zvuka

Otvorite projekt Projekt2.aup3 koji ste samostalno izradili u
prethodnoj vjezbi i spremili u mapu Projekti.

Ako nemate spomenutu vjezbu, koristite se projektom
Projekt2.aup3 koji se nalazi u mapi Vjezbe.

Naraciju podijelite u isjeCke prema odlomcima.
IzbriSite tiSinu izmedu isjecaka.

Odvojite isjeCke tako da izmedu njih bude 7 sekundi.
Zamijenite drugi i treci isje€ak naracije.

Skratite pozadinsku glazbu da vremenski traje jednako dugo
kao i naracija.

Smanijite intenzitet pozadinske glazbe preko kontrolne plo¢e
zvuCne trake, da ne ometa zvuk naracije.

Napravite postupno poja¢anje intenziteta zvuka pozadinske
glazbe na pocetku trake i postupno smanjivanje intenziteta
zvuka na kraju trake.

Izmedu isjeCaka potrebno je pojacati pozadinsku glazbu
postepenim pojacavanjem i smanjivanjem intenziteta zvuka

PresluSajte dodane izmjene.

Spremite projekt pod nazivom Projekt3.aup3 u mapu Projekti.
Spremljeni projekt koristit ¢e se u sljedeéoj vjezbi.
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6. Primjena i vrste efekata

Po zavrSetku ovog poglavlja polaznik ¢e moci:

e  primijeniti efekte na zvucnu traku ili njezine dijelove.

Zvucni efekti koriste se za naglasavanije i korekciju cijelog i djela zvuka.
Audacity posjeduje veliku koli€inu efekata koji se koriste za
izobli€avanje i promjenu zvuénog zapisa, kao $to je promjena brzine,
uklanjanje Sumova, pojaCanje i smanjivanje intenziteta, izolacija
naracije itd.

6.1. Primjena efekata

Za primjenu efekta potrebno je oznaditi dio zvuénog zapisa i odabrati
Zeljeni efekt iz izbornika Effect. Nakon odabira efekta otvorit ¢e se
prozor s postavkama efekta u kojem je, pomocéu naredbe Preview,
moguce posludati zvuéni zapis s primijenjenim efektom prije nego sto
se sam efekt primijeni na odabrani dio zvuénog zapisa.

6.2. Vrste efekata

Audacity uklju€uje mnogo efekata i takoder ima mogucnost dodavanja
novih pomoéu dodataka.

NajceSce koristeni efekti su:

¢ Noise Reduction — smanjuje pozadinsku buku kao §to su
glasovi, zvizdanje, Sumovi i sl. Za smanjivanje pozadinske buke
potrebno je odabrati dio zvu&nog zapisa koji sadrzi uzorak
pozadinske buke. NajceSc¢e je to tidina izmedu reCenica. Nakon
odabira pozadinske buke potrebno je kliknuti na Get Noise
Profile iz dijaloSkog okvira Noise Reduction u izborniku Effects.
Zatim se odabere dio zvu€nog zapisa na kojem se Zeli smanijiti
pozadinska buka i u dijaloS§kom okviru Noise Reduction dugme
OK.

Moise Reduction *

Step 1

Select a few seconds of just noise so Audacity knows what to filter out,

then click Get Noise Profile:
Get Moise Profile

Step 2

Select all of the audic you want filtered, choose how much noise you want
filtered out, and then click 'CK! to reduce noise.

Moise reduction (dB): .
Frequency smoothing (bands): '

Moise: (® Reduce () Residue

Cancel
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Amplify — smanjuje ili povecCava intenzitet za odredeni broj

decibela.

Amplify — [m| x
Amplification (dB): | Bl

v
New Peak Amplitude (dB):

[JAllow clipping

Manage Preview 0K Cancel

Change Speed — mijenja brzinu za odredeni postotak uz

promjenu visine tonova.

Change Speed - [m| X

Change Speed, affecting both Tempe and Pitch

Speed Multiplier: | LEEHY Percent Change: | 0.000

Standard Vinyl rpm:  from | 33 v| to |33% ~

Selection Length

CurrentLength: |00 h00m09.285s
MNew Length: 00h00mD09.286¢s~

Manage Preview 0K Cancel

Change Tempo — mijenja brzinu za odredeni postotak bez

promjene visine tonova.

Change Tempo - u] X

Change Tempe without Changing Pitch

Percent Change: | 14.961

Beats per minute
Length (seconds)

from | 028 to

[ Use high quality stretching (slow)

Manage Preview Cancel

Echo - [m| X

Delay time (seconds):
Decay factor:
oK

Manage Preview Cancel

36
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Fade Out — postupno smanjuje intenzitet oznacenog dijela

zvu€nog zapisa do tisine.

il

n

Fade In — postupno pojacava intenzitet ozna¢enog dijela

zvucnog zapisa pocevsi od tiSine.

il

by

Repeat — ponavlja oznaceni dio zvu€nog zapisa Zeljeni broj

puta.
Repeat - ] x
MNumber of repeats to add:
Current selection length: 00 h 00 m 06.0753 s
New selection length: 00 h 01 m 06.827 s
Manage Preview oK Cancel 0

Bass and Treble — smanijuje i pojaCava niske i visoke

frekvencije neovisno jedne o drugo;.

X

Bass and Treble - o
Tone controls

(e v

Treble (dB): ]
Output

Volume (dB):

[ Link Volume control to Tone controls
Manage | | StartPlayback | Skip Backward | Skip Forward | [7]Enable Close Ay | @
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6.3.

1.

o g &> W

Vjezba: Primjena efekata

Otvorite projekt Projekt3.aup3 koji ste samostalno izradili u
prethodnoj vjezbi i spremili u mapu Projekti.

Ako nemate spomenutu vjezbu, koristite se projektom
Projekt3.aup3 koji se nalazi u mapi Vjezbe.

Oznadcite svaki pojedini isje€ak naracije i smanjite pozadinsku
buku. Kao uzorak pozadinske buke mozete koristiti tiSinu
izmedu recenica.

Oznadcite srednji isje€ak naracije i dodajte efekt jeke.
Preslusajte dodane izmjene.
Spremite projekt pod nazivom Projekt4.aup3 u mapu Projekti.

Izvezite zvuénu datoteke MP3 formata u mapu Projekti.
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7. Vjezba: Miksanje zvuka

Miksanjem se mogu stvarati novi zvu¢ni zapisi iz postojec¢ih
koristenjem alata za promjenu intenziteta zvuka, premjestanjem,
spajanjem i preklapanjem traka i isjeCaka te uporabom razlicitih
efekata.

1. U mapi Vjezba 7-1 nalaze se razli€iti zvu¢ni zapisi. U Audacityju
otvorite sve datoteke iz spomenute mape i podesite intenzitet zvuka
svake trake kako bi neke zvuéne zapise naglasili, a neke postavili u
pozadinu. Zvuéna datoteka Vjezba_7-1.mp3 mozZe posluZiti kao
inspiracija za miksanje.

2. Mapa Vjezba_7-2 sadrzi zvu€ne zapise s razli€itim instrumentima
pomocu kojih mozete izraditi viastiti glazbeni miks. Iskoristite barem 6
razli€itih zvu€nih zapisa i izradite glazbeni miks u trajanju od najmanje
45 sekundi. Za inspiraciju moZzete koristiti zvuénu datoteku Vjezba_7-
2.mp3.

3. Koristec¢i zvu¢ne zapise iz mape Vjezba_7-3 napravite glazbeni miks
Sto sli¢niji onom u datoteci Vjezba_7-3.mp3.
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Prilog 1. — Detaljnije o radnom sucelju

Glavni izbornik

Moguc¢nosti glavnog izbornika su:

e File —rad s projektima Audacityja i drugim zvucnim
datotekama

o Edit — obrada zvuénog zapisa
e View — prikaz zvu¢nog zapisa i alatne trake sucelja
e Transport — kontroliranje snimanja i reprodukcije

e Tracks — dodavanje, brisanje, poravnavanje i ozna¢avanje
zvuénih zapisa

e Generate — stvaranje novih zvukova (ton, tiSina ili Sum)
pomocu raznih dodataka

o Effect — kolekcija raznih efekata za obradu zvuka
e Analyze — analiza zvu¢nih zapisa

e Help — pomo¢, snimanje zaslona i razne informacije.

Alatne trake

Kako bi se pojedine alatne trake prikazale ili sakrile, potrebno ih je
odabrati iz popisa koji se prikazuje u izborniku View - Toolbar.
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Alatne trake su:

Device — nudi mogucnosti biranja izvora snimanja i
reprodukcije (npr. biranje izmedu viSe zvucnih kartica)

Windows W ~ -.!) Microphone (Realtek High C ~ || 2 (Stereo) Record ‘D Speakers (Realtek High Defir ~

Edit — nudi moguénosti obrade (kopiranje, rezanje, brisanje) i
pregleda zvu€nog zapisa (povecavanje i smanjivanje)

KOO wih «~~ & QQ

Recording Meter Toolbar — prikazuje ja¢inu signala mikrofona
u realnom vremenu

L J 0 ; 0 0 l ; ; ; i
\.!J R -54 -45 -42 — Click to Start Monitoring ——18 -12 -5 ]

Playback Meter Toolbar — prikazuje jaCinu zvuka reprodukcije
u realnom vremenu

o) ; 54 45 43 3 3 24 18 42 & D
Mixer — regulira jaCinu zvuka snimanja i reprodukcije
- + - +
\ o ) o

Selection — kontrolira frekvenciju zvuénog zapisa projekta,
mogucénost Snap To i prikazuje to€no vrijeme reprodukcije

Project Rate (Hz) | Snap-To Start and End of Selection ~
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Tools — ukljuCuje alate za oznaCavanje zvu¢nih zapisa, zatim
njihovo brisanje, premjestanje i dodavanje efekata
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Transcription — omogucuje reprodukciju sporije ili brze od
originala
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Audacity ili kako snimiti i obraditi zvuk u vlastitoj produkciji (R500)

e Transport — omogucuje kontroliranje reprodukcije, snimanje i
gibanje klizaCa kroz projekt.
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Zvuéni zapisi

Dio sucelja sa zvuénim zapisima sadrzi prikaz mono i stereo zvuénih
traka s postavkama o kojima se moZe viSe procitati u poglavlju 4.1.
Prikaz zvuénog zapisa.
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Biljeske:



